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About this manual 
Thank you for choosing an Accusys RAID storage solution. This manual takes you step by 
step through the installation and configuration of the RAIDGuard X software. 

 
PART ONE: Introduction 

Chapter 1: Introduction provides an overview of the software and its features. 
PART TWO: Software Installation 

Chapter 2: Installing RAIDGuard X on Windows 
Chapter 3: Installing RAIDGuard X on Mac OS 
Chapter 4: Installing RAIDGuard X on Linux 

PART THREE: Basic RAID Configuration 
Chapter 5: RAIDGuard X Server 
Chapter 6: Basic Configuration using RAIDGuard X Client 

PART FOUR: Advanced RAID Configuration 
Chapter 7: Advanced Configuration 

PART FIVE: Appendices 
Appendix A: Glossary – defines relevant technical terms used in this manual. 
Appendix B: RAIDGuard X GUI Icons – lists the icons and their functions used in the 

application. 
Appendix C: Introduction to RAID Levels – describes all available RAID levels of this 

software. 
Appendix D: Contact Us – lists contact details of Accusys business units around the  

world. 

Guide to conventions 
Important information that users should be aware of is indicated with the following icons: 
 

 

 
This icon indicates the existence of a potential hazard that could result in 
personal injury, damage to your equipment or loss of data if the safety 
instruction is not observed. 

 

 

 This icon indicates useful tips on getting the most from your software. 

 
Important terms, commands and programs are put in Boldface font. 
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Introduction 
 



Chapter 1 – Introduction 

 

Using this section 
Part 1: The RAIDGuard X User's Manual supplements the ExaRAID, eXpeRAID, and iRAIDer 
User's Manuals. It is intended to be read in a linear manner. Users may prefer to skip more 
familiar sections, but each of the steps below must be completed. 
 

 
 

Install: Install RAIDGuard X Server and Client on your system. 
 

  
Configure: Configure the RAIDGuard X Client to manage the RAID 

arrays. 
 

  
Manage: Manage the RAID arrays, fix problems and be alerted to 

any problems. 
 
 

 

 The set-up procedures in Windows versions, MAC and Linux environments 
are different although the steps above are the same for both. 

 Windows users should refer to Chapter 2. 
 Apple Mac users should refer to Chapter 3. 
 Linux users should refer to Chapter 4. 
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Chapter 1 

Introduction  
 

 
      

 This chapter introduces the features and capabilities of the 
RAIDGuard X software. You will find: 

 A full introduction to your RAID controller 
 Details of key features 

 

 

      

 

Overview 
RAIDGuard X is a powerful tool which supports remote monitoring of multiple controllers that 
are connected to the same network.  
The software comes with 2 components: Server and Client. 
Server - Enables the server to recognize the RAID controller(s). 
Client - The Client software can be installed on any computer that needs to administer the 
controller(s). 
The Client software works on any computer running Java 1.6 or above and is used to 
administer the RAID controller(s). It contains all the functionality needed to configure and 
administer RAID arrays. Use the software to: 

 add and delete arrays 
 fix problems with disks 
 manage the arrays and disks 
 set audio and e-mail alerts 
 monitor the status of multiple controllers 

 

Key Features 
RAIDGuard X is designed to be used in conjunction with Accusys PCIe series: 

 Supports multiple Accusys PCIe Re-drive cards per host 
 Java Based Graphical User Interface (GUI) 
 Multi-platform and operating system support 
 Remote monitoring 
 Event notification 
 Snapshot function 

RAIDGUARD X CLIENT GUI 
The graphical user interface enables easy monitoring of the status of a RAID in an intuitive 
format. 

EVENT NOTIFICATION 
Email event notification keeps the administrator informed of the status of the RAID controller. 
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Remote Monitoring 
The RAIDGuard X Client must be installed on a Java-based computer in order to view the 
details of the RAID controller away from the server. 

Installation prerequisites 
RAIDGuard X is designed to be used in conjunction with Accusys PCIe series. Users require 
the following: 

Hardware requirements 
 CD-ROM drive 
 Accusys PCIe controller and Re-drive card (installed) 

Software requirements 
 RAIDGuard X GUI (follow the instructions in the relevant Setup section to download 

from the Accusys website http://www.accusys.com.tw) 
 Supported operating system 
 Java-based application environment 

Before You Start 
Before RAIDGuard X can be installed on Windows, Mac, and Linux platforms, make sure you 
have completed the following: 

 Install the RAID controller and hard disk drives into the chassis. 
 Install the RAID Re-drive card to your host server (for ExaRAID users only). See the 

ExaRAID User's Manual. 
 Turn on the chassis (for ExaRAID and iRAIDer users only). 
 Launch the operating system and install the driver. For Windows and Mac users, the 

driver is packed into RAIDGuard X, whereas Linux users have to install the driver 
separately. 

 

http://www.accusys.com.tw/
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Software Installation 



 

 

Installation flowchart 
The set up process follows these steps: 
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 Install the appropriate driver. 
 
 
 
 
 
 

Install  
drivers 

 Install RAIDGuard X Server and/or Client on the host server. 
 Install RAIDGuard X Client on your workstation(s) for the 

remote connection. 
 
 
 

Install 
RAIDGuard X 

 Launch RAIDGuard X Client on your host server or remote 
computer. 

 Choose a target controller to configure. 
 Configure controller settings, disk arrays, and system 

preferences. 
 
 

Configure 
RAIDGuard X 

 RAIDGuard X Client can also be installed on workstations to 
remotely access the controller through the same network. 

 

  

Administer the 
RAID array 
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Chapter 2 

Installing the driver and 
RAIDGuard X on Windows   

 

 
      

  This chapter details the installation, setup and configuration 
process for RAIDGuard X on a Windows operating system. 
RAIDGuard X Server must be installed on the host server.  
RAIDGuard X Client must be installed on each computer that 
will monitor or administer the RAID controller(s). 

 

      

 
Driver Installation 
1. Insert the CD-ROM into the CD-ROM drive of the server or PC. 

2. Execute “CD-ROM/Windows installation/Driver/x.x/(x64, x32 and IA64)/ 
(2000, XP, 2003 and Vista, 2008)/ACS6_xxxxport_xx.msi”. 

3. Follow the onscreen instructions. 

4. Click Finish to complete the installation. 

RAIDGuard X Installation 
1. Insert the CD-ROM into the CD-ROM drive of the server or PC. 

2. Execute “CD-ROM/Windows installation/GUI/x.x/ 6xxxx_IP_Win_x.x.exe”. 

3. Follow the onscreen instructions. 

4. When installing on the host server, select Complete to install the Server 
and Client. 

5. When installing on a remote computer, select Custom to choose which 
applications (Client or Server) to install. 

6. Click Finish to complete the installation. 

7. Restart the computers. 
 

  
 Storport and miniport are new storage drivers created by Microsoft for 

Windows Server 2003 and future Windows® operating systems. 
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Chapter 3 

Installing the driver and 
RAIDGuard X on MAC OS   

 

 
      

  This chapter details the installation, setup and configuration 
process for RAIDGuard X on the Mac operating system. 
RAIDGuard X Server must be installed on the host server.  
RAIDGuard X Client must be installed on each computer that 
will monitor or administer the RAID controller(s). 

 

      

 
Driver Installation 
1. Insert the CD-ROM into the CD-ROM drive of the server or MAC. 

2. Execute “CD-ROM/Drivers/MAC/ 6xxxx_DR_MAC_x_x_x.pkg”. 

3. Follow the onscreen instructions. 

4. Click Finish to complete the installation. 

RAIDGuard X Installation 
1. Insert the CD-ROM into the CD-ROM drive of the MAC. 

2. Execute “CD-ROM/MAC Installation/ Vx.x/ 6xxxx_IP_MAC_x_x_x.mpkg”. 

3. Follow the onscreen instructions. 

4. When installing on the host server, select Complete to install the Server 
and Client. 

5. When installing on a remote computer, select Custom to choose which 
applications (Client or Server) to install. 

6. Click Finish to complete the installation. 

7. Restart the computers. 
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Chapter 4 

Installing the driver and 
RAIDGuardX on Linux   

 

 
      

  This chapter details the installation process for RAID Guide X 
Server and Client on a Linux operating system. RAIDGuard X 
Server must be installed on the host server. RAIDGuard X 
Client must be installed on each computer that will monitor or 
administer the RAID controller(s). 

 

      

 
Driver Installation 
1. Insert the CD-ROM into the CD-ROM drive of the server or PC. 

2. Open CD ROM/Driver/Linux/6xxxx_DR_Linux_x.x.x/ (It’s necessary to 
have compiler tool in your Linux system before you install driver.) 

3. If you want to boot the host server with RAID, open the folder for your OS 
version and follow the instructions in the file "readme.txt". 

4. If your Linux system boots from local HDD, refer to /SourceCode/ 
readme_Linux source code.txt to build the drivers. 

RAIDGuard X Installation 
Before installing RAIDGuard X, make sure the RAID HBA driver is already installed in 
your Linux OS. 
1. Insert the CD-ROM into the CD-ROM drive of the server or PC. 

2. Open CD ROM/GUI/Server/Linux/AP/i386 or x86_64/AP_Accusys. Open 
a terminal window on the desktop, and enter the following commands: 

# cat /proc/devices 

Check the "ACS_CDEV" device number. For example, if the 
"ACS_CDEV" device number is "$$$": 
Example: 
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#  mknod /dev/ACS_CDEV0 c $$$ 0 
Example: 

 
#  cd /root/ 

#  unzip RAIDGuard X Server x.x.zip 

#  cd /Linux/AP 

#  chmod 777 DTRGuiSrv  

# ./DTRGuiSrv 
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3. Open CD-ROM/GUI/Client/x.x. Open a terminal window on the desktop, 

and enter the following commands: 

# java -version 

Check your JAVA version. If your JAVA version is earlier than 1.6, 
please go to www.java.com to upgrade. 
Example: 

 
#  cd /root/ 

#  unzip RAIDGuard X Client x.x.zip 

#  cd /Client/x.x 

#  chmod 777 RAIDGuardX.jar 

#  java -jar RAIDGuardX.jar 

PS: To change the OS default JAVA path, open a terminal window on the desktop, 
and enter the following commands: 

# vi /etc/profile 

Insert the following context description into /etc/profile  

(Replace the correct Java version that you installed in the following.):  
export JAVA_HOME="/usr/java/jre1.6.0_14" 

export JRE_HOME="$JAVA_HOME/jre" 

export PATH="$JAVA_HOME/bin":$PATH: 

export CLASSPATH=.:"$JAVA_HOME/lib":"$JRE_HOME/lib": 

Example: 

 

# reboot 
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Chapter 5 

RAIDGuard X Server   
 

 
      

  This chapter details the usage of the RAIDGuard X Server. 
Before you can access the RAID controller, you must load the 
RAIDGuard X Server on the host server.    

 

      

 
The RAIDGuard X Server is responsible for communicating with the RAID controller. Its 
purpose is to identify that the RAID controller is connected to the host server. 
Insert the software CD-ROM into the host server CD-ROM drive and select RAIDGuard X 
Server from the menu. 

Windows 
Once installed, the RAIDGuard X Server will look for available 
RAID controllers each time you enter the operating system. When a 
RAID controller is found, a popup window appears. 

An icon will be added to the Windows notification area. Right click 
on the icon to display the following options: 
1. Run at Windows Startup – Uncheck to prevent RAIDGuard X 

Server from starting when Windows starts. (Default) 
2. Remove from Windows Startup – Check to remove 

RAIDGuard X Server from the Windows startup menu. 
3. Exit – Close RAIDGuard X Server. 
 

  
 If the RAIDGuard X Server icon is not displayed, go to Start > Programs > 

Accusys > RAIDGuard X > RAIDGuard X Server. If the RAIDGuard X 
Server is not visible, reinstall the software. 
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If a RAID controller cannot be found, the following message will be 
displayed. 

 

 

 If a controller is connected to the host server, check that the RAID Re-drive 
card is installed correctly and then restart the host server.  

If a controller is not connected to the host server, make sure RAIDGuard X 
Server is removed from Windows Startup. Right click the RAIDGuard X 
Server icon and check Remove From Windows Startup. 

 

Mac Users 
RAIDGuard X Server will automatically load itself and run as a daemon program during Mac 
OS system startup. 
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Chapter 6 

Basic Configuration using 
RAIDGuard X Client   

 

 
      

  This chapter details the basic usage of the RAIDGuard X 
Client. Use this application to administer RAID arrays. It 
covers functions such as adding and removing controllers and 
arrays, and e-mailing alerts to administrators.    

 

      

 

Starting 
Before starting, ensure that the RAID controller has been configured in the BIOS of the 
RAID Re-drive card. To start RAIDGuard X Client, either click the desktop icon or go to 
Start > Programs > Accusys > RAIDGuard X > RAIDGuard X Client. 
 

The menu bar across the top contains the following functions: 
File –  

Exit – Close the program. 
Clear Log – Clear the event log. 
Load Controller List – Refresh the ontroller list.    
Language – English and Japanese are supported.   

 

 

These events are automatically saved in RAIDGuard X\Application\Log 
as .txt files. 

 

 
 

Controller –  
Manual Add Controller – Enter the IP address, serial number, and password of a 

controller.  
Update – 

Update System Code – Click to update the firmware of the controller. 
Update Boot Code – Click to update the boot code of the controller. 
Update BIOS & EFI – Click to update the BIOS or EFI of the controller.  
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 Before updating the firmware, Boot code or BIOS, Right click the 
RAIDGuard X Server icon in the Windows notification area, and check 
Remove From Windows Startup. 

If you want to use Mac to boot, please use EFI. 

 

    
 

 

 Do NOT unzip the gzip file before installation. 

 
Help –  

About RAIDGuard X – Displays information about the RAIDGuard X version. 
Help Center – Displays the help for RAIDGuard X. 
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/  Adding and Removing Controllers 
 
 

In order to administer a controller, it first needs to be added to the network. Once added, the 
administrator is given full control over the controller. 
 

Adding 
Click the Add Controller button to display a list of available controllers on the network. Click 
on the one to administer, enter the password (the default password for the Accusys PCIe 
controllers is 00000000 (8 zeros)) and click Add. 
Controller Name 
You can assign a name to the controller. 
 

 

 The maximum number of controllers that can be displayed is 100. 

 

 
Once the controller has been added, five tables are displayed: Controller, Array, Drives, 
Snapshot, and Event. 
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Controller Info  
The controller info tab provides details on the vendor, model name, controller name, serial 
number and memory size. It also has 3 tabs: Firmware, Hardware, and Power. 
 

The Firmware tab details the system 
version, boot version, BIOS version 
and EFI version 

The Hardware tab details the CPU 
temperature, controller temperature, and 
fan speeds. 
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The Power tab details the battery 
module, battery capacity, and power 
status. 
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Array 
The Array & Drives tab provides details on the status of the drives, such as which array they 
are assigned to. It also has 2 radio buttons: Array and Drives. 
 

The icons next to each drive will change 
depending on whether the Accusys PCIe 
controller is installed. The number above the 
drive indicates the array number. 

 
Clicking the Array radio button displays 
information about the array: the array number., 
status, RAID type, stripe size, sector size, RAID 
Level, capacity, and slice. 

 
Clicking the Drives radio button displays 
information about individual drives. Click on 
each drive image to view the drive number, 
status (OK or Failed), drive type (RAID or 
Spare), model, revision status and capacity. 

 

 
 
 

25 
 



 RAIDGuard X User’s Manual

 
Drive 
Displays the overview of all drives for the selected controller. 
 

 
 
Snapshot 
The progress of the snapshot is displayed in the snapshot tab. To enable the snapshot 
function, see Options > Snapshot. 
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Event 
Displays a list of the most recent events. These events are automatically saved in 
RAIDGuard X\Application\Log as .txt files. 
 

To clear the log, click File > Clear Log. 
 

 

 
 
 

27 
 



 RAIDGuard X User’s Manual

 
 

Removing 
To remove a controller, select a controller and then click the Remove Controller button to 
remove the controller from the table. When the popup window appears, select Yes. 
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/  Creating and Deleting Arrays 
 

Administrators can choose how best to distribute the available hard disk drives. Once an 
array has been created, it can be further administered in the Options section. 
Creating an Array 
When the RAID controller is first configured, an array needs to be set up. This array tells the 
controller how many disks to use and what their function should be. The Accusys PCIe 
controllers support RAID levels 0, 1, 5, 6, 0+1 and JBOD. 
Follow the steps below to create an array: 
Step 1: Select the RAID level from the drop down menu. Available levels are: 0, 1, 5, 6, 0+1 

and JBOD. Each level has a minimum disk requirement and this is shown in the 
information to the right of the drop down list. 

 

 Details on the RAID levels are in Appendix C, Introduction to RAID 
Levels. 

 
Step 2: Select the stripe size from the drop down menu. Available stripe sizes are: 8-256KB. 

The greater the stripe size, the faster the I/O output for each drive. This speeds up 
disk access. 
Select the sector size from the drop down menu. Available sector sizes are 512 
bytes (default) and 4096 bytes. The sector size 4096 bytes is only supported by 
Windows 2000/XP, and over 2 Terabyte function is used. For another OS, please 
select 512 bytes (default). 

 

 For an explanation of stripe sizes, see Appendix A, Glossary. 

 
Step 3: Click on the drives to be added to the array. You can also click on Select all spare 

drivers. 

 

 The image displayed will vary depending on which controller is being used. 
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Optional: From the drop down menu, select either On the fly initialization or Performance 
evaluation. 

On the fly initialization – The default setting is for normal use. The data and parity will 
be initialized automatically. The performance will degrade to some degree during the 
initialization process. 
Performance evaluation – Select to evaluate the performance of the target array. 
Data and parity are not initialized. (No data protection when this mode is on) 

 

Assign LUN automatically 
Check this box to automatically assign a LUN. 
 
 

Click Create Array to complete the process. 
 

 
 
 

30 



Chapter 6 – Basic Configuration using RAIDGuard X Client 

 
Delete an Array 
Deleting an array removes the selected array, and allows the drives to be used in another 
array, or reconfigured for a new array. Follow the steps to delete an array. 
Step 1: Click on the drives containing the array to be deleted. 
Step 2: Check the Confirm box. Click Delete Array to complete the process. 
 

 

 
 

 

 When you delete an array, all data on the hard disk drives will be lost. 
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 Email 
 

It may be necessary for network administrators to receive e-mails in the event of errors, alerts, 
and changes to the RAID array. These alerts can be e-mailed to a maximum of 20 e-mail 
addresses. 
Mailing List 
Enter the e-mail address(es) of people to receive controller error reports. 
Click Remove to delete e-mail addresses from the list. 
Click Send Test Email to check that the e-mail is working. 
 

SMTP Setting 
Mail Server Name – Enter the address of the mail server. 
From Email Address – Enter the e-mail address of the mail server. 
 

SMTP Server – requires authentication for user name and password 
Check this box if your mail server requires a user name and password. 
 
SMTP POST event 
Check this box if you wish to create a log for error events. 
 

 

 

 Ask your systems administer for SMTP Server details. 
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Chapter 7 – Advanced Configuration 

 
Chapter 7 

Advanced Configuration   
 

 
      

  This chapter details the advanced usage of the RAIDGuard X 
Client. It covers such functionality as alarms, modes, slicing, 
and expansion.    

 

      

 
 

 Preferences 
 

This menu allows administrators to set the conditions of the controller, such as performance 
modes, caching, and miscellaneous functions. 
There are 3 tabs under Preferences: Mode, Cache and MISC.. 
 

Mode: 
Disk Lag Proof Mode – Check this box to activate Disk Lag Proof Mode. A disk I/O lag on a 
single drive of a RAID set introduces delays in delivering data from an entire RAID set. Disk 
Lag Proof Mode limits these delays by regenerating data from parity and returns data to the 
host on time. In return for limiting the delays, there is a minor performance loss when this 
mode is enabled. 

 

 This function does not support JBOD and NRAID. 

 
NCQ – Check this box to activate Native Command Queuing. It allows several outstanding 
commands to be given to the drives at one time, therefore increasing the performance of the 
hard dives. 

 

 For an explanation of NCQ, see Appendix A, Glossary. 

 
SMART Mode – Check this box to activate SMART Mode. Choose from 1 minute to 8 hours 
the number of minutes for SMART Mode to be active. SMART Mode monitors the 
performance of the hard drives to predict hard drive failure. 
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Beeper – Check this box to sound an audible alarm in the event of an error.    
 

Equalization Mode – Check this box to smooth the performance of sequential I/Os and 
reduce fluctuation (peak performance will be reduced). For video editing, enable equalization 
to prevent video frame drops. 
 

SAN Performance Equalization Mode – Check this box to provide high sustained 
performance and prevent video frame drops in a SAN environment. (This option is for SAN 
environment only) 

 

 

 
 
 

36 



Chapter 7 – Advanced Configuration 

 
 
Cache:  
Controller Cache – Check this box to enable the controller cache. This speeds up the data 
transfer to and from the disks. 
 

Synchronize Cache – Check this box to enable cache synchronization. When Synchronize 
Cache mode is disabled, the RAID controller works correctly but does not actually perform 
any cache flushing. For video capture, disable synchronization because the video capture 
needs to be able to constantly write data to the RAID storage without long 
SYNCHRONIZE_CACHE latency.  
 

Read Pre-fetch – Identifies sequential access patterns and aggressively pre-fetches patterns 
into cache. From the drop down list, choose the number of stripes to pre-fetch. The default is 
32; this is the recommended number. 
 

Drive Cache – Choose which drives to cache. When more than one application accesses the 
database, the first applications cache needs to synchronize with the second. Each drive 
contains a built in write cache; checking these boxes chooses which drives to enable the 
caching on. Caching improves the efficiency and speed of data transfer. 
 

All Drives Cache On/All Drives Cache Off – Click this button to enable/disable the caching 
on for all available drives. 

 

 
 

MISC:  
Controller Time – Click this button to see a calendar and to change the time and date of the 
controller. 
 

Password – Enter the new controller password. The default password is 00000000 (8 zeros). 
Type another 8 characters. 
 

Password Confirmation – Confirm the new controller password. 
 

SNMP Notification – Select SNMPv1 or SNMPv2 to receive notifications for error conditions 
and possible problems with the servers. 
 

 
 
 

37 
 



 RAIDGuard X User’s Manual

 
SNMP Target – Enter the IP address for receiving the SNMP notifications. 
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 Options 
 

The Options menu provides the methods for changing the details of and fixing problems with 
the array. Click on the radio button for the required option, and then click Next to proceed. 
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 Slicing 
 

Hard drive slicing partitions the drives of an array, so that it appears as a separate volume 
without reducing the speed. 
Follow the steps below to select an array to slice or merge. 
 

Step 1: Select the array to slice or merge by clicking on a drive with an array number. The 
capacity is displayed. By default, Slice 0 contains the entire capacity of the disk 
array. 

 

 
 

Step 2: Click on Slice 0, and use the slide bar or buttons to free space for creating other 
slices. Click OK to confirm. 
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Step 3: Click on the slice to create, and use the slider bar or buttons to adjust the size. Click 

OK to confirm. 
Step 3: Check the Confirm box and click OK. 

 

 

 Slices must be adjusted in order; for example, Slice 0, Slice1, Slice 2, etc.    

Each array supports a maximum of 8 slices. 
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 LUN Map 
 

A LUN is a unique identifier used on a SCSI bus that enables it to differentiate between up to 
eight separate devices. Use the LUN map to attach a unique identifier to a slice. 
Follow the steps below to map a LUN. 
 

Step 1: Select the array to map by clicking on a drive with an array number. 
Step 2: Choose a LUN and from the drop down list select a series to map to. Repeat for 

multiple LUNs. 
Step 3: Check the Confirm box and click OK. 

 

 

For an explanation of LUNs, see Appendix A, Glossary.  
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 Expansion 
 

Expansion allows the adding of extra drives to an array without the need to rebuild the array. 
This is carried out online without the need to stop data transfer. 
Follow the steps below to select an array to expand. 
 

Step 1: Select the array to add additional drives to, and select the number of drives to be 
added. A “+” sign appears above the drives to be added. 

Step 2: Check the Confirm box and click Expand Array. 
 

 
 

 

 It is only the number of drives that can be chosen, not the specific drive. 
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 Migration 
 

Migration allows RAID types to be changed without the need to delete the array and rebuild. 
This can be useful when new drives have been added, and a new array type needs to be 
created. 
Follow the steps below to select an array to migrate. This changes the RAID type, such as 
from RAID 1 to RAID 5. 
 

Step 1: Select the array to migrate. From the drop down menu, select the RAID level to 
migrate to, then select the total number of drives to include in the array. A “+” sign 
appears above the drive(s) to be added, and a “-“ sign above the drive(s) to be 
removed. 

Step 2: Check the Confirm box and click Migrate. 
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 Snapshot 
 

The snapshot function mirrors the data from one slice onto another, thereby backing up the 
data. From the drop down menu, select from Create shot, Delete shot, Split shot, and 
Resynchronize shot. 
 

Create Shot 
Creates a snapshot of the selected slice. A maximum of 8 shots can be created. Once all 
shots have been used, older shots must be deleted before new ones can be taken. 
 

Step 1: Select the Create Shot function from the drop down menu. 
Step 2: Select the required shot by clicking on the Shot No. radio button. From the 

respective drop down menus, select the source volume and destination volume. 
Unavailable shots are greyed out. 

Step 3: Check the Confirm box and click OK to take a snapshot. 
 

 
 

Delete Shot 
Deletes the selected shot. 
 

Step 1: Select the Delete Shot function from the drop down menu. 
Step 2: Select the required shot by clicking on the Shot No. radio button. From the 

respective drop down menus, select the source volume and destination volume. 
Unavailable shots are greyed out. 

Step 3: Check the Confirm box and click OK to delete a snapshot. 
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Split Shot 
Split Now— 
Splits the selected shot or changes scheduling. The shot is split and read as two separate 
shots; therefore, it becomes two separate slices after being split. 
 

Step 1: Select the Split Shot function from the drop down menu. 
Step 2:   Select the Split Now radio button. 
Step 3: Select the required shot by clicking on the Shot No. radio button. From the 

respective drop down menus, select the source volume and destination volume. 
Unavailable shots are greyed out. 

Step 4: Check the Confirm box and click OK to split the snapshot. 
Split Scheduling— 
Set any time to split shot. 
Step 1: Select the Split Shot function from the drop down menu. 
Step 2:   Select the Split Scheduling radio button. 
Step 3:   Click on the time and date button to set split time. 
Step 4: Select the required shot by clicking on the Shot No. radio button. From the 

respective drop down menus, select the source volume and destination volume. 
Unavailable shots are greyed out. 

Step 5: Check the Confirm box and click OK to split the snapshot. 
Cancel Scheduling— 
Cancel the split shot scheduling. 
Step 1: Select the Split Shot function from the drop down menu. 
Step 2:   Select the Cancel Scheduling radio button. 
Step 3: Select the required shot by clicking on the Shot No. radio button. From the 

respective drop down menus, select the source volume and destination volume. 
Unavailable shots are greyed out. 

Step 4: Check the Confirm box and click OK to split the snapshot. 
 
Resynchronize shot 
Resynchronize the selected shot. This function can speed up mirroring for previous 
snapshots. 
 

Step 1: Select the Resynchronize shot function from the drop down menu. 
Step 2: Select the required shot by clicking on the Shot No. radio button. You can only 

select split shot for resynchronization. 
Step 3: Check the Confirm box and click OK to split the snapshot. 
 

 

 
 1. The destination volume must be larger than the source volume. 

2. The source volume and the destination volume can be on different arrays. 
3. The destination volume must NOT be mapped to a LUN. 
4. A shot will not be deleted if the details of the array change. The only way to 

delete a shot is using the Delete Shot  function under Snapshot. 
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The progress of the snapshot is displayed in the snapshot tab of the front window. 
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 Health Center 
 

If there are problems with the array, the health center can help to resolve them. 
Follow the steps below to select an array to verify, rebuild, or condition. 
 

Step 1: Select the Array to verify, rebuild, or condition. 
Step 2: Click the radio button to: 

Rebuild parity data – Rebuilding parity on an array uses the data on the array to 
create new parity data, not repair problems with the data. 
Verify parity data –Verify that the data is free of errors. 
Refresh array data and parity – Select the priority between Low, Med., or High. 
This process scans, rewrites, and scrubs bad data conditions caused by excessive 
vibration during drive I/Os, or data degradation caused by Adjacent Track 
Interference (ATI).   

Step 3: Click OK to start the operation. 
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 Unlock drives 
 

Locked drives are drives that for one reason or another have stopped being recognized by the 
controller. 
Follow the steps below to select a drive to unlock or change the ID. 
Locked drives prevent the accidental loss of user data when drives are installed one at a time, 
or a RAID member is accidentally removed while the controller is powered-on. The meta-data 
and user data on the locked drives are preserved for online/offline recovery. If users don’t 
need the data of the locked drive anymore, the locked drive can be changed into a spare 
drive by the command of Unlock Drive. 
 

Step 1: Select the drive with the  icon. It will change to the  icon. 
Step 2: Check the Confirm box and click Unlock Drive. 
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Appendix A 
Glossary  

 
Array 
See Disk Array. 
 
Cache 
Controller memory used to speed up data transfer to and from a disk. 
 
Disk Array  
A collection of disks from one or more commonly accessible disk controllers, combined with a 
body of array management software. The array management software controls the disks and 
presents them to the array operating environment as one or more virtual disks. 
 
Firmware 
BIOS firmware is a type of boot loader run by the host server when first powered on. 
 
Host Computer  
Any computer system to which disks are directly attached and accessible for I/O. Mainframes, 
servers, workstations, and personal computers can all be considered host computers in the 
context of this manual, as long as they have disks attached to them. 
 
LUN 
A LUN (Logical Unit Number) is a unique identifier used on a SCSI bus that enables it to 
differentiate between up to eight separate devices (or logical unit). Each LUN is a unique 
number that identifies a specific logical unit, which may be an end user, a file, or an 
application. 
 
Native Command Queuing (NCQ) 
NCQ allows several outstanding commands to be given to the drives at one time. The 
commands are carried out in sequence instead of the order they are given, rather like 
pressing buttons in a lift; the lift goes to the next floor in the list, not the order that the buttons 
are pressed. This speeds up the disk access and reduces the load on the drives. 
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Parity 
Parity information is redundancy information calculated from actual data values. If any single 
piece of data is lost, the remaining data and the parity information can be used together to 
calculate the lost data. Parity information can either be stored on a separate, dedicated drive, 
or be mixed with the data across all the drives in the array. 
 
RAID (Redundant Array of Independent / Inexpensive Disks) 
A disk array in which part of the storage capacity is used to store redundant information about 
user data that is stored on the remainder of the storage capacity. The redundant information 
enables regeneration of user data in the event that one of the array member disks or the 
access path to it fails. See Parity. Different RAID levels offer different data throughput speeds 
and fault tolerance (data redundancy). RAID 0 does not feature redundant information but is 
nonetheless considered a type of RAID. 
 
SMART (Self-Monitoring, Analysis and Reporting Technology) Mode 
SMART Mode monitors the performance of the hard drives to predict hard drive failure. 
 
Stripe Size 
Stripe size is the maximum number of sectors the RAID system can access without accessing 
another disk. The stripe size is also the size of the cache for the RAID. A larger stripe is 
preferable since it reduces the number of I/O requests made to a physical disk and lets the 
buffer cache work more efficiently. 
 
Slicing 
Unlike striping, slicing allows the creation of arrays from a single disk, without a loss of speed 
as the disk fills up. This is because when striping across disks, the center of the disk fills up; 
and when it’s being written to, it slows down. Slicing creates new disk partitions with similar 
characteristics, therefore keeping the speed the same. 
 
EFI (Extensible Firmware Interface) 
EFI is a replacement for the original BIOS firmware. Originally developed by Intel, it redefines 
how firmware communicates with the operating system. It contains such information as: 
platform-related details, boot, and runtime service calls. 
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Appendix B 

RAIDGuard X Icons  
 
This chapter details the icons used in this application and their use. 

ICON Description 

Main Menu Icons 

RAIDGuard X Server icon – The icon that is on the desktop and 
notification area.  

 
Add / Delete a controller – Select the controller to administer. 

 
Create / Delete an Array – Change the arrays within the RAID. 

Preferences – Activate alarms, mode settings, cache settings, 
password, and controller card time.  

 
Email – Set the addresses to send e-mail alerts to. 

Option – Set the Slice, expansion, migration, health, disk locking, 
LUNs, and take a snapshot of the array.  

Option Menu Icons 

 
Slicing an array into several parts 

 
LUN Map – Assign a LUN to a slice 

 
Expand an array to larger capacity by adding disks 

 
Migrate from one RAID level to another target RAID level 

 
Snapshot – Create a backup of a slice 

 
Health Center – Repair/Maintain arrays 

 
Unlock – Fix locked drives 
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ICON Description 

Application Icons 

A drive  

 
A drive belongs to Array 1, 2, 3, 4 

 
A drive being deleted in Array 1, 2, 3, 4 

 
A JBOD drive being selected 

 JBOD being deleted 

 A drive being selected 

 An offline drive 

 A locked drive 

 A drive being selected for expansion / migration / rebuilding 

 
A transition drive state during the array 1, 2, 3, 4 migration 

 
A transition drive state during the array 1, 2, 3, 4 migration 

 
A transition drive state during the array 1, 2, 3, 4 auto-rebuild 

 

RAID Levels 
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Appendix C 
Introduction to RAID levels  

 
The Accusys PCIe series can support the following RAID levels: 0, 1, 0+1, 5, 6 and 
JBOD. 
 
Which is the right level for you? The answer depends on the application you use your 
RAID for. 
 
RAID Level 0 offers high transfer rates, and is ideal for large blocks of data where speed is of 
importance. Computer aided design, graphics, scientific computing, image, and multimedia 
applications are all good examples. However, if one drive in a RAID 0 array fails, the data on 
the whole array is lost. 
 
RAID Level 1 may be an appropriate choice if cost and performance are of significantly less 
importance than fault tolerance and reliability. 
 
RAID Level 0+1 offers a compromise between the reliability and tolerance of level 1, and the 
high transfer rates provided by level 0. 
 
RAID Level 5 arrays offer high I/O transaction rates, and are the ideal choice when used with 
on-line transaction processing applications, such as those used in banks, insurance 
companies, hospitals, and all manner of office environments. These applications typically 
perform large numbers of concurrent requests, each of which makes a small number of disk 
accesses. If one drive in a RAID 5 array fails, the lost data can be rebuilt from data on the 
functioning disks. 
 
RAID Level 6 is similar to RAID level 5. A second set of parity information is written across all 
the drives. This is equivalent to double mirroring. This level may be more fault tolerant than 
necessary, and has poor performance. 
 
JBOD is a method of arranging multiple disks that is not technically a RAID at all. Under 
JBOD (“Just a Bunch of Disks”) all disks are treated as a single volume, and data is 
“spanned” across them. JBOD provides no fault tolerance, or performance improvements over 
the independent use of its constituent drives. 
 
This appendix provides a summary of the features of each RAID level, to enable users with 
differing requirements to make the best choice. 
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RAID 0 
RAID 0 links each drive in the array as one huge drive. Storage capacity is determined by the 
smallest drive in the array. That capacity is then applied to format all other drives in the array. 
If using a 40 GB, 60 GB, and 50 GB drive in a RAID 0 array, your system will see one huge 
drive of 120 GB (40 GB×3).  
RAID 0 offers double or more performance under sustained data transfers when one drive per 
ATA port is used. In such a configuration, unlike Fibre, ATA drives are always available to the 
system. Fibre requires more management of the Fibre bus. 
 

RAID 0: Striped disk array without fault tolerance 

Characteristics: Recommended use: 
 RAID 0 implements a striped disk array, the data 

is broken down into blocks and each block is 
written to a separate disk drive. 

 I/O performance is greatly improved by spreading 
the I/O load across many channels and drives.  

 Fastest and most efficient array type but offers no 
fault-tolerance.  

 Storage capacity = (No. of disks) × (capacity of 
smallest disk) 

 Video production and 
editing 

 Image editing 
 Pre-press 

applications 
 Any application 

requiring high 
bandwidth 

 
The diagram below represents the writing of data on a RAID 0 array composed of four HDDS 
connected to the controller. Data blocks are distributed across all disks in the array. 

 

 

Arrangement of data blocks saved on a Level 0 RAID 
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RAID 1 
RAID 1 is commonly referred to as Disk Mirroring, Disk Shadowing or Disk Duplexing as all 
data is duplicated across both disks. RAID 1 can only be performed with two hard drives (with 
four drives, RAID 0+1 is configured automatically). As data is identical on both disks, storage 
capacity is that of the smaller disk. RAID 1 has poor performance for write operations but very 
high performance for read intensive operations. 
 

RAID 1: Mirroring 

Characteristics: Recommended use: 
 Better Read transaction rate then single disks, 

same Write transaction rate as single disks. 
 100% redundancy of data means no rebuild of 

data is necessary in case of disk failure, just a 
copy to the replacement disk. 

 All the disks have the same data. 
 RAID level 1 requires two drives. 
 Storage capacity = Capacity of smaller disk 

 Accounting 
 Payroll 
 Financial 
 Any application 

requiring high 
availability 

 

 

Arrangement of data blocks saved on a Level 1 array 
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RAID 0+1 
RAID 0+1 combines mirroring and striping functions on a minimum of four hard disks. 
Mirroring provides full redundancy and protects data in case of multiple drive failure (providing 
that data on one of each mirrored pair of drives is intact). 
 

RAID 0+1: Combination of striping and mirroring 

Characteristics: 
 This configuration provides optimal speed and reliability. 
 Requires even number of disks (minimum 4 disks). 

 
The diagram below represents the writing of data on a RAID 0+1 array composed of four 
HDDS connected to the controller. The controller creates a RAID 0 array from two RAID 1 
sub-arrays. 

 

 
Arrangement of data blocks saved on a Level 0+1 array 
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RAID 5 
RAID 5 uses a mathematical expression that compares data from two drives and calculates a 
third piece of data called “parity”. Should one of the drives fail, parity data can be used to 
rebuild the failed data. Under RAID 5, parity data is stored across all drives in the array. This 
maximizes the amount of storage capacity available from all drives in the array while still 
providing data redundancy. Data on RAID 5 is block-interleaved. 
 

RAID 5: Independent data disks with distributed parity blocks 

Characteristics: Recommended use: 
 Each entire data block is written on a data disk. 

Parity for blocks in the same rank is generated 
on Writes, recorded in a distributed location and 
checked on Reads. 

 Highest Read data transaction, medium Write 
data transaction rate. 

 Relatively low ratio of ECC (Parity) disks to data 
disks means high efficiency (compared to other 
RAID levels). 

 Good aggregate transfer rate. 
 Storage capacity = (No. of disks – 1) × (capacity 

of smallest disk) 

 File and application 
servers 

 Database servers 
 WWW, E-mail and News 

servers 
 Intranet servers 
 Most versatile RAID level 

 
The diagram below represents the writing of data on a RAID 5 array composed of four HDDS 
connected to the controller. Parity blocks are represented by the letter P. 

 

 

Arrangement of data and parity blocks saved on a Level 5 RAID 
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RAID 6 
RAID 6 stripes blocks of data and parity across an array of drives like RAID 5, except that it 
calculates two sets of parity information for each parcel of data. The goal of this duplication is 
solely to improve fault tolerance; RAID 6 can handle at most one fault. Performance-wise, 
RAID 6 is generally slightly worse than RAID 5 in terms of writes due to the added overhead 
of more parity calculations, but may be slightly faster in random reads due to spreading of 
data over one more disk. As with RAID levels 4 and 5, performance can be adjusted by 
experimenting with different stripe sizes. 
 

RAID 6: Independent data disks with double parity blocks 

Characteristics: Recommended use: 
 Array Capacity: (size of smallest drive) x 

(number of drives-2). 
 Storage Efficiency: If all drives are the same 

sizes, then ((number of drives –2) / number of 
drives). 

 Fault Tolerance: very good to excellent. 
 Requires a minimum of four drives. 

 File and application 
servers 

 Database servers 
 WWW, E-mail and News 

servers 
 Intranet servers 
 Apply to high reliability 

servers environment 
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JBOD 
JBOD (“Just a Bunch of Disks”) reports the individual drives. The operating system will see 
each drive in the JBOD mode as an individual drive. There is no RAID protection in the JBOD 
mode. The JBOD mode allows the user to connect more hard drives without taking up IDE 
connections on the motherboard. 
 

JBOD: Spanned disk array without fault tolerance 

Characteristics: Recommended use: 
 JBOD reports individual disks. 
 No fault-tolerance. 
 Poorer I/O performance than RAID 0  
 Storage capacity = Sum of constituent drive 

capacities 

 For most uses not 
requiring fault 
tolerance, RAID 0 is 
better. JBOD has the 
advantage if you are 
using several drives 
of different capacities. 

 

PCI-e

RAID Controller

40G

30G
20G

40G
30G

20G

Disk 1

Disk 2
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Host

Physical Drive

Disk 1

Disk 2

Disk N

 

Arrangement of data saved on a JBOD array 
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Appendix D 
Contact Us  

Taiwan - Headquarters 
• 5F, No.38 Taiyuan St. Jhubei City, Hsinchu County, Taiwan 302, R.O.C. 
• TEL: +886-3-5600288 
• FAX : +886-3-5600299 
• WEB: www.accusys.com.tw/ 
• SALES: sales@accusys.com.tw 
• SUPPORT: support@accusys.com.tw 

Taiwan - Factory 
• No.263 Neli Sec. Guanpu Rd., Hsinpu, Hsinchu County, Taiwan 30544, 

R.O.C. 
• TEL: +886-3-5895500 
• FAX : +886-3-897700 

USA 
• 45120 Pawnee Drive, Fremont, CA 94539  
• Tel :+1-510-661-0800 
• FAX :+1-510-661-9800 
• WEB: www.accusys.com/ 
• SALES: maggie@accusys.com.tw 

China – Beijing office 
• No.9A, Tower B, Yingdu Mansion, No.48 Zhichun Street, Haidian 

District, Beijing 100098, China  
• TEL: + 86-10-58734580/81/82/83 
• FAX: +86-10- 58734585 
• WEB: http://www.accusys.cn 
• SALES: sales@accusys.com.cn 
• SUPPORT : support@accusys.com.cn  
• FTP: ftp.accusys.com.cn  
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China – Accusys Technology, Shanghai 
• Rm 203, No.678, Kirin Tower, Gubei Road, Changning Area, Shanghai 

200336, China  
• TEL: + 86-21-62708599 
• FAX: +86-21- 62708580 
• WEB: http://www.accusys.tw 
• SALES: stone@accusys.com.cn 

Korea 
• Baegang B/D 5F Shinsa-Dong 666-14 Kangnam-Gu, Seoul, Korea 
• TEL: +82-6245-9050 
• FAX: +82-3443-9050 
• WEB: http://accusys.co.kr/  
• SALES & SUPPORT: sales@accusys.co.kr 

 

 


